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Scheduling 
 

Important Note to First Time Users: 
If this is the first time you are using the Schapptbook, please refer to sections 2.17 
and 2.18 to set up your user preferences. 
 
2 Scheduling 
 
2.1 Basic Entry and Screens 

 
Application Used: SCHAPPTBOOK.exe 
 
• Open  SCHAPPTBOOK.EXE and enter you Login ID.  Press <Tab> or click on the 

password field and enter your password in lower case.  Press <Enter> or click on the 
“OK” button at the bottom of the screen.   

• Select the appropriate bookshelf. 
• Click on the Books tab in the upper left corner of the Scheduler screen.   
 

Figure 2-1 
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• To open the appropriate scheduling book, double-click the selected book. 

• Go to the requested date. 

• Click on the Calendar to select and view the requested day. 

• Find an available room and time 
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2.2 Setting up the Demographics Bar 
 
Application used: SCHAPPTBOOK.exe 
 
To select the preferences for screen display: 
 
• Launch Scheduling Appointment Book (Schapptbook.exe).  Log in as yourself. 

• To view Demographics Bar, click on View tab and select Demographics Bar 

• Right-click on the yellow demographics bar and select Properties 

• From the Attributes box, select the field you want to add/update to the demographic 
bar 

• Click the add/update/delete tab based on your preference 

• To update:  Click on the drop down arrow and select the quadrant you want the field 
displayed.  If you want to change the font, click on the font tab and select your 
choices.  Click OK 

• To add:  Click on the drop down arrow and select the quadrant you want the field 
displayed.  If you want to change the font, click on the font tab and select your 
choices.  Click OK 

• To delete:  Click on Delete tab.  Click OK. 

• To add/remove rows on the demo bar, click on the up/down arrows to the right of the 
demo bar 

• To add/remove columns on the demo bar, click on the right/left arrows below the 
demo bar 

To select additional preferences for screen display: 

• Launch the Scheduling Appointment Book Application.  Log in as yourself. 

• Double-click on the OR scheduling book 

• Click on the Appointment tab 

• Right-click anywhere on the appointment book, select Book Settings>View>and 
select how you want to view the appoinment book (weekly, monthly, proportional, 
non-proportional) 

• Right-click anywhere on the appointment book, select Book Settings>Data/Time, 
and set up how you want to view the appt book based on date and time. 

• Right-click anywhere on the appointment book, select Book Settings>Properties, 
and setup visible day range, display tooltips, appt icons, binder display 
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2.3 Scheduling an Appointment 
 
Application used: SCHAPPTBOOK.exe 
 
To enter an appointment for that day, click on the Appointment Tab.  This will bring up 
the “Appointment Accept Format”  (a list of information that must be gathered for each 
appointment).   
 

Figure 2-2 

 

N
a
c

 NOTE:  Fields displayed in yellow are required and must be completed.

 
• Appointment Type: Surgery (required field) 

• Appointment Location: (required field) 

• Person Name: Type in name and enter.  (required) 
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OTE:  You can set a default to desired location by going to View > Options > 
ppointment tab > default location.  Otherwise enter by typing the location name or 
hoosing from dropdown box. 
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Figure 2-3 
 
A person search box will display with names that match. If the name of the person is 
listed, click on it.   Click on the Modify box to enter additional information if needed.  
Click the OK button at bottom of search box when finished. 
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If the name is not found, click on ADD PERSON.   A Scheduling Quick Reg window 
will appear.  
 
Complete the required fields (shown with a white background).  Optional fields will be in 
grey.    Once the pertinent information is filled out, click OK. 
 

 

Figure 2-4 
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• Primary Surgeon:  (required) In the Name field, begin typing the surgeon’s last 

name.  The name will default into the field if there is only one person that matches the 
first few letters typed. The more letters typed, the more narrow the search.  If nothing 
matches what you’ve typed, press ‘enter’ and a provider search window as seen 
below will appear. This will display in alphabetical order, the names that are around 
the letters you typed in the field.  

 

 

Figure 2-5 
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Figure 2-6 

• Patient Type: (required) Choose ONLY ONE of the following:   Inpatient, 
Outpatient, Observation, or OP/Admit.  There will be other options, but DO NOT 
choose them. 

• Classification: (required) Enter one of these options:  OR Elective, OR Urgent, OR 
Emergency 

• Surg Add on: In the event there is an add-on case, this will need to be documented.  
Enter “Y” for yes or “N” for no and the value will auto populate. 

• Surgeon 2, 3, 4: Enter the surgeon’s last name for any surgeons who are scheduled 
for a case in addition to the primary surgeon. 

• Anesthesiologist:  (required)  ‘To perform conflict checking for the anesthesiologist 
role, enter the either Anesthesiologist, SEGA’ or ‘Anesthesiologist, CMC’.  If the 
surgeon will be the anesthesiologist for the case, choose ‘Anesthesiologist/Surgeon, 
A.    This latter selection will not perform conflict checking. 
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• Diagnosis:  This field is not required, but will default into nursing documentation if 
entered here. 

 

 

Figure 2-7 
 
• Public Surgical Comments: These may be comments such as Request MD 

Anesthesia, Latex Allergic, etc.  These comments will be published on the externally 
distributed 

• Private Surgical Comments: This may be used for information that will not be 
distributed externally.  For example, patient is morbidly obese, or patient is HIV 
positive. 
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Figure 2-8 
 
• Under the Orders tab, in the middle box (free text field), type in the first few letters 

of the surgery procedure, and press enter.  Pressing enter will initiate the database 
search.  Please refer to the your standard procedure list if you have difficulty finding 
the surgery procedure. 

• This will display a list of procedures from which to select. 

• Double-click on the appropriate procedure.  Double-clicking on the procedure is the 
ONLY way to add the order to the surgery case. 

• The box on the right will populate with the Procedure Accept Format (fields to 
complete). 

• Primary Surgeon: (required)  Defaults in from Appointment Accept Format  

• Anesthesia Type: (required)  Defaults in from Appointment Accept Format 
(required).  This field is populated with the Anesthesia type most commonly 
associated with the procedure.  You may need to modify this field. 
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• Surg Procedure Duration:  (required) historical average or recent average data for 
surgeon/procedure.  Click on the default duration radio button.  Once a case has been 
completed with the surgeon and procedure there will be historical data in which you 
may select the radio button of historical or recent average.  Notice the 
historical/recent/default duration are dithered, you cannot modify these duration.  If 
none of the duration times are appropriate for this case, you may select the Override 
radio button and enter the number of minutes in the duration field.   Note:  The 
duration will always be in the unit of minutes. 

 

Figure 2-9 

 

• Primary Procedure:  (required)  Type a “Y” for Yes or “N” for No  

 

 

 

Note: There MUST be one and ONLY one primary procedure scheduled for a case.  
Make sure and verify that there is one procedure that is indicated as primary. 
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• Procedure Description: This is a free text field.  Type in the description exactly as 

you accept it in the scheduling conversation, i.e. Left Total Hip *Osteonics, or 
Excision Lesion Right Forearm. 

• Concurrent Indicator: This will be used for multi-procedure cases only. Click on the 
down arrow in the box labeled Concurrent, and select YES, in order for the system to 
except the longest of the two duration values for these cases.  Otherwise choose NO, 
and the system will add the two duration values together.  You may also override a 
duration, by clicking on the Override radio button, and entering a duration time. 

• Surg Proc Modifier 1: This is where the procedure modifier may be scheduled.  The 
field for surg proc modifier 1 will be associated to the primary procedure.  The field 
for surg proc modifier 2 will be associated with the second procedure that was added 
to the case and so on. 

• Setup Time/Cleanup Time: This will default the setup time from the procedure.  
You may change this duration if necessary.  Note, if you keep the setup and clean up 
times, you are scheduling the duration of the procedure as well as the setup and 
cleanup times.   

• For multi-procedure cases, enter the additional procedure(s) in the search box and 
press enter. 

 
CONFIDENTIAL 

Copyright © 2002 Cerner Corporation 



2-14 Section 2 ORMA End User Guide 
 Scheduling Version 2.0 
 

 

• Double-click on the appropriate procedure.  Again, the Procedure Accept Format will 
be populated with the default values (Surgeon, Anesthesia Type, Procedure Duration, 
Setup and Cleanup, etc.) 

• After you have entered all the information for the procedure(s),  Click OK 

 
The information should now be displayed in the Work In Progress window. 
 

 
Figure 2-10 
All of the Available Room Resources will now display for you to schedule. 
 
There are a couple of ways to schedule the case. 
 
• Find the slot and the time you want to schedule the case and click on it.  Click on the 

“Schedule” button. 

• First click on the schedule button and enter the time and room information manually. 

 
• Find the slot and the time you want to schedule the case, right click on it, and select 

‘Book Request’. 

• Once the information has been entered, click OK. 

• The appointment will appear in yellow with a red outline in the slot in pending status 
until you confirm. 

• The Books that appear next to each resource in the work in progress window will 
change to red if there are no booking conflicts 

• Click OK. 
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Figure 2-11 

• Check to make sure that all the information is correct.  Each case should show a date, 
time, duration, area and the surgical room.  Below, the Orders should be displayed 
always noting the primary procedure.  To the left, you should always have a surgical 
area a room, a patient and a surgeon.   

• Click on the Confirm button when you are done. 

• When the appointment is in the confirmed state it will appear in the designated colors 
for a confirmed case at your hospital. 

 
CONFIDENTIAL 

Copyright © 2002 Cerner Corporation 



2-16 Section 2 ORMA End User Guide 
 Scheduling Version 2.0 
 

 
NOTES 
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2.4 Rescheduling an Appointment 
 
Application Used: SCHAPPTBOOK.EXE 
 
You can Reschedule an Appointment two different ways: 
 
• Select the patient’s appointment. 

• Click the Reschedule button  on the toolbar.  The system displays the appointment 
in the Work-In-Progress window.  (It will also continue to be displayed in its 
currently scheduled location.) 

• Click the Schedule button. 

• The Schedule window opens.  Verify that the default scheduling information is 
correct. 

• Reschedule the case as desired.   

• Click OK.  

 
 
 
 
 

Note:  If a message is displayed saying the system is unable to schedule the surgeon 
or person at the same time due to lack of availability, select each of these 
components and schedule them individually for the same date and time. 

 
• Click the Confirm button to open the Summary Dialog of the scheduled appointment.  

The scheduled resources (including the patient) for the appointment, along with its 
corresponding start date, time, duration, and location are displayed.  

• Click OK to confirm the appointment. 

 
CONFIDENTIAL 

Copyright © 2002 Cerner Corporation 



2-18 Section 2 ORMA End User Guide 
 Scheduling Version 2.0 
 
 

• A Reschedule combo box opens.  

 

 
Figure 2-12 

• Select the appropriate reason from the list in the Reschedule Reason dialog box. 

• Click <OK>.  The appointment is rescheduled. 

 
 
 
 
 

Note:  To view the original appointment in the book on the original day, click the 
menu option of View and select Reschedules.      Repeat this step to deselect 
Reschedules and turn this off. 
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The Other Way to Reschedule a Case is to: 
 
• Double click on the OR Rooms book, or the book your site has named. 

Figure 2-13 
 
• On the calendar in the Appointment book, select the date originally scheduled.  You 

should see an appointment scheduled for that date/time. 

• Right click on that appointment and select Action→Reschedule. This pulls the 
appointment into the Work in Progress Window.   

• Left click in the desired specified time and block.   

• Click the Reschedule button.  The Schedule Case window appears.   

• Click the Confirm button.  A Reschedule Reason window comes up.  Select the 
appropriate reason and click OK.   
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NOTES 
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2.5 Canceling an Appointment 
 
Application Used: SCHAPPTBOOK.EXE 
 
Cancel Case: There are two ways to cancel a case:   
 
If you know the date and time for the case you wish to cancel then go to it in the 
appointment book and click on it. Right click and a window will display. Click on Action 
and another window will display with a list of options.  Click on cancel 
 

OR 
 
• Click the case you scheduled for the patient in the scheduling grid. 

• Click the Cancel button  on the toolbar. 

• Select the Cancel Reason of Physician Request from the list. 

• Enter any additional information in the Comments field. 

• Click OK 

 
 
 

Note:  Modifications and Reschedules may also be accomplished 
from this window. 
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Figure 2-14 
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Provide a Cancellation reason from the drop down box, and type any necessary or helpful 
comments, such as who cancelled the case, or additional helpful information for future 
review. 
 
Click on OK. 
 

 
Figure 2-15 
 
Frequently, the case being cancelled is not currently displayed, or you might not know on 
which date and time it was scheduled.  In such instances, it is easier to locate the 
necessary case by performing the following steps: 
 
• Click the Appointment Inquiry button   on the toolbar. 

• Under the Person tab, accept the default of Person Schedule Inquiry for the Inquiry 
Type. 

• Enter the person’s name in the Person field and accept the defaults for the date and 
time fields. 

• Press the Find button and locate the person’s appointment that was scheduled earlier. 

• Right click the confirmed appointment and select Cancel. 
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• Select the Cancel Reason of Patient Request and click OK.  The appointment is now 
updated with the status of Cancel and is removed from the Appointment Book. 

• Press the Close button to exit the Appointment Inquiry window.  Do not close the 
Appointment Book. 

 
 
 
 
 

Note:  To view the original appointment in the book on the original day, click the menu 
option of View and select Reschedules.  Repeat this step to deselect Reschedules and 
turn this off. 
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2.6 To Shuffle Cases 
 
Application Used: SCHAPPTBOOK.EXE 
 
Shuffling cases is an easy way to quickly reschedule multiple cases.  Any changes in case 
duration must still be done by rescheduling cases individually. 
 

Figure 2-16 
 
 
• Select the date on which you want to shuffle cases.  

• Push the Shuffle Icon on the tool bar or right-click in the scheduling grid and select 
Action → Shuffles.   

• The “Appointment Shuffle Criteria” window will come up and verify the resources 
(rooms), date, begin time, and end time of cases to shuffle (the room values will 
default to all rooms in the appointment book that you have open).  Click on the “OK” 
button. 

• Use the scroll bars to locate the cases that you want to shuffle. 
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• Left- click and hold down on the case that you want to move and drag it to the new 
room and start time. As you move each case it will turn a color your hospital team has 
determined to help you keep track of which cases will be moved. 

 

 

 

 

Note:  When changing the order of multiple cases in a single room it may be 
necessary to move the first case to an adjacent room or empty spot to make space to 
move other cases to that location. 

• When finished moving all cases click on the “OK” button.  All moved cases will have 
a conflict check performed on them.  You may get conflicts on the SSISNOPERSON, 
XX if you shuffle those cases.  You will need to resolve any patient conflicts before 
you can continue. 

• Select a shuffle reason and click on “OK”. 
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NOTES 
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2.7 Adding Appointment Instructions 
 
Application Used: SCHTOOLS.EXE 
 
Building Instructions are useful because they act as an information guide for the 
scheduler. The scheduler can use the Instructions to give the patient or physician’s office 
information about the procedure, directions to the hospital, patient preparations, etc.  
 
 Expanding that branch displays text types Post Appointment Instructions and 
Preparations.  Expanding the Preparations branch could show the subtext types of Patient 
Instructions, Directions to Location, Procedure Descriptions, and so on.   
 
2.7.1 Building Instructions:  
 
• Open SchTools.exe 

Figure 2-17 

• Expand the Instructions tool 

• Expand the Preparations level until you see Directions & Preparations. 

• Double-click Directions to open the below window.  
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Figure 2-18 

• In the Mnemonic field, enter the free text name of these particular directions.   

• In the Text field, enter in any information that you want to display as directions in the 
Appointment Book.  

• Click Save button 

• Click Close button 

• Repeat process for Preparations using the Preparations tool.  

• Repeat process for Post Appointment Instructions using the Post Appointment 
Instructions. 
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2.7.2 Associating Instructions to the Appointment Type 
 
• In SchTools.exe, open the Appointment Type tool and locate the appointment type 

you want to associate the Instructions to. 
 

Figure 2-19 
 

• On the left side of window, find Instructions and expand until you see Directions, 
Preparations and Post Appointment Instructions. 

• Highlight Directions 

• In the first column called All Locations, select the appropriate surgical area.  

• In the second column called All Directions, select the appropriate directions.  

• Click the   to move the location and directions to the last column called Selected 
Directions.  

• If more than one direction is associated, you can arrange the appearance order of the 
directions by utilizing the up and down arrows next to the last column.  

• Repeat the process for preparations by clicking Preparations. 
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• Repeat the process for post appointment instruction by clicking Post Appointment 
Instructions.  

• Click Save.  

• Click Close. 

• All Instructions can be viewed in SchApptBook.exe upon case confirmation as well 
as post case confirmation.   
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2.8 Viewing Appointment Instructions 
 
Application Used: SchApptBook.exe 
 
2.8.1 Viewing Instructions at confirmation 
 
• Schedule and confirm case 

Figure 2-20 
 

• In the confirm dialog window, Preparations appear under the Orders section.  
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Figure 2-21 

 

• Scroll down to view the Post Appointment Instructions.  

• If you choose not to view Preparations or Post Appointment Instructions, un-select 
the “Show Patient Preparations” and “Show Post Appointment Instructions” 
checkboxes.  

• User can print these instructions by clicking the Print button.  

• Click OK to close window 
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2.8.2 Viewing Instructions after the case has been confirmed 
 
• Right click on case > Inquiry > Appointment View 

OR 
• Right click on case > Inquiry > Appointment History View 

Figure 2-22 
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• In the Appointment View/Appointment History View window, go to the Instructions 

tab. 

 

• In the Instructions Type field, select Preparations or Post Appointment Instructions 
from the list to view the appropriate instructions. 

 

Figure 2-23 

 
• Click Close to exit window. 
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2.9 To Find an Appointment 
 
Application Used: SCHAPPTBOOK.EXE 
 
• Open the SchApptBook.exe.  

• Click the Appointment Inquiry Icon (the eye). 

• To search for a case by case number, click the resource tab. 

 

Figure 2-24 
 
• Type in the Surgical Case #.  You will be able to put wildcards (*) in your search.  

Click find. 

• The possible cases appear in the right screen. 

• Right-click on the case to perform any scheduling action on it (reschedule, cancel, 
etc.) without going into the appointment book. 
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• You can also search by person (click the person tab), surgeon, OR Room, etc. 

 

Figure 2-25 
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2.10 Case Inquiry 
 
Application Used: SCHApptBook.exe 
 
 

Figure 2-26 

 
• On the appointment book, click inside the room. Right click anywhere on the book 

and a box will appear, select inquiry, then appointment inquiry.  
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• At the top of this screen you have three tabs to choose from.  Person, location, 

resource, if all tabs do not appear click on the arrows next to them to display. 

• If selecting person, type portion of name on Person and press enter to find.  Double-
click on the person name.   Enter a date range you wish to search.  Click on Find. 

 

Figure 2-27 

 
• A list with all information about cases scheduled for that patient will appear. To see 

all information, use the arrows to scroll across the screen. 
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2.11 Viewing Appointment History 
 
Application Used: SchApptBook.exe 
 
• Open the SchApptBook.exe 

• On case in scheduling grid,  right click →Inquiry →Appointment History View  

 

Figure 2-28 
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Figure 2-29 

 
• On the right side of the Appointment History View window, it shows how many 

times the case has been modified.  

• In the General tab, it shows who performed that specific action in the Action 
Information section. In this example, Cerner confirmed the case on February 22, 2001 
at 6:17 PM.   

• You can also navigate throughout the other tabs within in this window. You can 
retrieve case information such as event details from the scheduling accept format, 
resources that are scheduled for the case, instructions for the case as well as other 
important pieces of information. 

• Click Close to exit out of the Appointment History View.  
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2.12 To Print Schedule Reports 
 
Application Used: SNSchRpt.exe 
 
• Launch the SNSchRpt.exe application 

• To create a new report, click on the new icon (green disk) 

Figure 2-30 

 
General Tab: 
 
• Select the date you want to run the report 

• Type the Name of the report 

• Select the location of “Main OR” 

• Type a header if desired – there are up to 3 lines for a header. 

• Do not enter anything for the PEAT Type as USAF is not using this functionality.   
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• The ops field is for ops job printing.  See Ops Job documentation for more on how to 

set this up.  

 
Data Fields Tab: 
 
• Selected Fields Column – Shows the complete display of fields.  This column is 

uneditable. 

• Display Column – This column shows you the header display that will be printed on 
the report for selected field.  This can be edited by clicking on the text and changing 
the text.   

• Size Column – This is the size of the selected field.  This can be edited as well. 

• The (+) that appears in the selected fields column symbolized the field is an 
Appointment Book field. 

 

Figure 2-31 
 
• Click on the appointment book icon. 

• Select a field type - indicates whether it is a case accept format or a procedure accept 
format. 
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• Type a header for the field, enter a size (numerical value) 

• Choose the appt type of “surgery” 

• Click in the value column next to the appt type you are using “surgery” and there will 
be a list of fields from the accept format you chose (see screen print on next page) 

Figure 2-32 
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Figure 2-33 
 
Printers Tab: 
 
• Select from a list of available printers where you want this report to be sent. 

• Enter the number of copies of the printed report 

• The > and < are the move arrows to add or remove a printer to the list. 
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Figure 2-34 
 
Filters/Orders Tab: 
 
This tab allows you to specify the filter criteria and select a sort option.  This is an 
optional tab. 
 
• Select a filter by: Patient Type or Specialty and choose what to Sort by: 
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Stacking Row Tab: 
 

Figure 2-35 
 
• This tab allows you to select additional data without extending the report beyond the 

margin of the paper. 

 
Row Header:  Description given to the row of additional fields 
 
Position:  This is the starting position of the stacking row on the report.  A position 
number of 0 will start the stacking row at the left margin of the report. 
 
Selected Fields:  These are the data fields that will be applied to the stacking row on the 
report. 
 
Available Fields:  This shows all the available fields that the application can retrieve and 
add to the stacking row.   
 
You have the ability to move these fields up, down, right, or left by using the move arrow 
icons. 
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Do not forget to save the report if you want this to remain in the list of regular reports to 
be run and printed.   
 
 
 
 
2.12.1 Print the Schedule 
 
The Schedule Report Builder application is used for printing the schedule to multiple 
locations around the facility.  This script guides the user in how a schedule would be 
printed.  The schedule requires a postscript printer queue. 
 
• Launch the Schedule Report Builder application (SNSchRpt.exe) on the AppBar. 

• Select Demonstration Report 1. 

• Enter a date range from the current date to tomorrow’s date.  

• Press Print Preview from the tool bar.  

• Verify that the report is displayed with the values from the date fields tab displayed as 
column headers.  The values from the case or cases should be displayed beneath.  
Additional values should be displayed in the Demonstration Row field.  

• Exit the application. 
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NOTES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
CONFIDENTIAL 

Copyright © 2002 Cerner Corporation 



ORMA End User Guide Section 2 2-51 
Version 2.0 Scheduling 

 
2.13 Modifying Appointment Details 
 
Application Used: SchApptBook.exe 
 
• Open the Appointment Book.  

• Find the case on the grid that you wish to modify. 

• Right click on the case on the grid, select “Actions” then left click on “Modify”. 

Figure 2-36 
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• Click on the “Details” tab to change any information listed in the case accept format 
such as priority, patient type, surgeon, etc. 

 

Figure 2-37 
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• Click the Orders tab to change any information listed in the procedure accept format 

such as Order (Procedure), anesthesia type, procedure modifier, etc. 

Figure 2-38 
 
• Click OK to go back to the appointment book. 
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2.14 Adding a Slot from Resource Scheduler 
 
Application Used: SCHAPPTBOOK.exe 
 
• Update the schedule by adding the desired block back in.  Right click →Slots →Add 

Slot in the scheduling grid in the room you want to add the slot. 

 

Figure 2-39 
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• In the Add Slot window, change the Day Begin time to the desired time and the Day 
End time to the desired time. 

• Set the desired Time Interval. 

• Click on the + next to Slot Groups then the + next to Surgery Group to show their 
contents. 

 

 

Figure 2-40 
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• Drag and drop the desired block to the Schedule section on the right. 

Figure 2-41 
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• Right click the new slot and select Properties. 

Figure 2-42 
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• In the Properties window in the Duration field, enter the slot duration. 

Figure 2-43 
 
• Click OK to close the Properties window  
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Figure 2-44 
 
• Click OK to add the block to the grid. 
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Figure 2-45 
 

 
CONFIDENTIAL 

Copyright © 2002 Cerner Corporation 



2-62 Section 2 ORMA End User Guide 
 Scheduling Version 2.0 
 
 

NOTES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
CONFIDENTIAL 

Copyright © 2002 Cerner Corporation 



ORMA End User Guide Section 2 2-63 
Version 2.0 Scheduling 

 
2.15 Removing a Slot from Resource Scheduler 
 
Application Used: SCHAPPTBOOK.exe 
 
• Update the schedule by removing the slot from the appointment book grid.   

• Right click →Slots →Remove Slot in the scheduling grid on the slot you want to 
remove. 

 

Figure 2-46 
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• If appointments were scheduled into this block, a Displacement Report dialog will 
display.  This allows you to print a report of all the appointments that will be 
displaced by removing the block from the schedule.   

• Select the appropriate printer from the Output Device field to print report. 

• Click cancel if you have not defined any print devices. 

 

Figure 2-47 
 

Figure 2-48 
 
 
• Click Yes to remove the selected slot. 
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Figure 2-49 
 
The Block will be removed from the scheduling grid and any displaced appointments 
would need to be rescheduled.  (Normally, cases would be rescheduled before a block 
would be removed.) 
 
If displaced appointments existed, you could drag them to the Work In Progress 
window, then drag, and drop the Resource set to another block. 
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2.16 Define User’s Options 
 
Application Used: SCHAPPTBOOK.exe 
 

Figure 2-50 
 
• Right click anywhere in the appointment book.  Select Book Settings  View.  You 

should select Proportional, Single Day to view all the cases in the appointment book 
on the same time scale. 

 
CONFIDENTIAL 

Copyright © 2002 Cerner Corporation 



2-68 Section 2 ORMA End User Guide 
 Scheduling Version 2.0 
 
 

• Right click anywhere in the appointment book. Select Book Settings  Properties. 

• On the General Tab: The visible day range should be the times in which your site can 
schedule. 

 

Figure 2-51 

• In Display fields, you can select information about the case that will appear in the 
appointment book.  Typically, for surgery appointments you should select Person to 
see the Patient, Primary Order to see the Primary Procedure, Surgeon 1, and probably 
Surgical Case Number if you use that as a confirmation number.  Click in the box 
next to the field you want to display and a checkmark appears.  To change the order 
of the fields select the field and use the up and down arrows to the right to move the 
field before or after the other fields. 
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On the View tab: 
 

Figure 2-52 

 
• To see the “binder” rings on the far left of the appointment book, check Display 

binder. 

• To set the time interval, click on the left side of the appointment book.  If you want to 
see more time    in less space, choose a larger interval.   ORMA recommends a 15-
minute time interval. 

• You can determine how wide each OR will display in the appointment book.  If you 
do not have very many OR’s, you might want to size to fit all.  If you have more 
OR’s, you can indicate a minimum width so that the display isn’t too small.  Or you 
can indicate a custom width.   

• To indicate the time at which you want the appointment book to default, scroll up and 
down to see other times once you’re in the application. 
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2.17 Define a Default Resource Book 
 
Application Used: SCHApptBook.exe 
 
 
• To set the default bookshelf for your sign on go to View > Options > Default Book 

and select the default bookshelf from the dropdown list. 

• Double-click on the book.  The appointment book will appear with a view of each 
room and the associated blocks. 

• Select the date by clicking on the calendar in the upper left-hand corner of the 
appointment book.  Use the right/left arrows to navigate between year and months. 

• In order to view the entire appointment book, use right/left arrows at the bottom of 
the screen to scroll left and right.  Use the up/down arrows on the right side of the 
screen to scroll up and down.   

 

Figure 2-53 
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2.18 Using the Calendar 
 
Application Used: SCHAPPTBOOK.exe 
 
Open SCHAPPTBOOK.exe 

The calendar is displayed in the Appointment Book.  You can select a date by clicking a 
specific date in the calendar.  The date that is selected currently is shown with a box 
around it.  The current date is the default date displayed on the calendar. 
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Figure 2-54 
 

• Use the arrow buttons to change the month and year displayed. 

• When you move an appointment to the Work In-Progress box to be scheduled, all 
dates that are available for that appointment will be displayed in bold on the calendar.  
This enables you to tell at a glance what days are available for scheduling.  The dates 
will display in bold to show these dates only if you enter a check in the Mark 
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qualifying days on calendar box in the Options dialog box, which is accessed from 
the View menu. 

• The Work In-Progress box displays appointments that are in the process of being 
scheduled.  The details associated with the appointment have been entered, but the 
appointment scheduling process has not been completed.  To continue, select the 
appointment that you wish to schedule and determine the resource and time with 
which it should be associated.  If the appointment type has a resource list associated 
with it, the system will select the appropriate resources automatically.  You can right-
click to display a menu of commands.  For a description of these commands, click 
here.  

• There are several ways to enter the appointment in a specific slot on the resource's 
schedule.  One way is to click Schedule to open the Schedule dialog box so you can 
enter specific information associated with the appointment.  

• Once the appointment is displayed in the time slot, click Confirm to finalize the 
appointment. 

• Under each person listed in the Work In-Progress box is a Schedule page.  This 
contains all scheduled appointments for the person so you can prevent scheduling 
conflicts when selecting dates, times, and resources for the appointment. 

  
2.18.1 Description of Buttons on the Calendar 
 
Button Description 
Schedule button Schedules the appointment based on the information entered. 

 
Confirm button Confirms or finalizes the suggested schedule for the 

appointment.  If the specific appointment is selected in the 
displayed box, click Confirm to finalize it.  If the person's name 
is selected in the box, click Confirm to finalize all scheduled 
appointments associated with that person. 
 

Recur button Opens the Recurrings dialog box so you can specify the days 
and number of instances the appointment should be scheduled. 
 

Suggest button Opens the Suggested Schedules dialog box, which allows the 
system to suggest an appropriate date and time to which the 
appointment can be scheduled based on criteria you enter. 
 

 

 
CONFIDENTIAL 

Copyright © 2002 Cerner Corporation 

Nancy Baldin
Should this be perhaps “Tool bar” instead?

Nancy Baldin
Please confirm the spelling here.



ORMA End User Guide Section 2 2-75 
Version 2.0 Scheduling 

 
2.18.2 Options Dialog Box 
 
The Options dialog box is used to define your default preferences that will be displayed 
each time you enter the Appointment Book.  This dialog box is accessed by selecting 
Options from the View menu.  The dialog box contains the following elements: 
 
 
Boxes Description 
Default Book box   Enter the name of the resource book to be displayed 

on the bookshelf as your default book.  There is a list 
available to assist you in selecting a predefined 
book. 
 

Days in Past box Enter the number of days that you can schedule an 
appointment in the past without receiving a warning 
message from the system.  For example, set this at 
"1".  If you are looking at a resource's schedule from 
the previous month and inadvertently try to schedule 
an appointment at that past date, the system would 
display a message letting you know you are 
attempting to schedule outside the predefined range. 
 

Days in Future box   Enter the number of days that you can schedule an 
appointment in the future without receiving a system 
message indicating you are attempting to schedule 
outside the predefined range. 
 

Health Plan Check box   Select this box if the system should automatically 
verify whether the person has an associated health 
plan, and if the date for which the appointment is 
being scheduled falls within the eligible coverage 
time for the health plan. 
 

Display Future 
Requests/Appointments   

Select this box if you want the system to display the 
Future Requests/Appointments dialog box 
automatically when you reschedule an appointment 
or schedule a request from the Schedule Inquiry 
window. 
 

Mark Qualifying Days on 
Calendar box   

Select this box to display dates that are available for 
scheduling a specific appointment.  When you move 
an appointment to the Work In-Progress box, the 
calendar will display all dates to which the 
appointment can be scheduled in bold. 
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Display Person Search 
Encounter window box. 

Select this box to display encounter information 
when using the Person Search functionality 
 

Allow Add Encounter box   Select this box if you want the ability to add an 
encounter during the scheduling process. 
 

Always Display Schedule 
Discrete Slots box   

Select this box if the Schedule dialog box should be 
opened whenever an appointment is scheduled into a 
discrete slot. 
 

Always Display Schedule 
Contiguous Slots box 

Select this box if the Schedule dialog box should be 
opened whenever an appointment is scheduled into a 
contiguous slot. 
 

Always Display Confirm 
dialogue box  

Select this box if the Confirm dialog box should be 
displayed whenever an appointment is confirmed. 
 

Use Best Encounter box. Select this box if your site has set encounter 
preferences and you wish to associate the 
appointment being scheduled with the best encounter 
as defined in your database.  The best encounter can 
be defined as the active encounter, the inpatient 
encounter, or future encounters 
 

Always Display PM 
Organization dialog … box 

Select this option if the Person Management 
Organization dialog box should be displayed every 
time you add an encounter. 
 

 
 
2.18.3 Appointment Tab Description 
 
View Person Flex Form box Select a defined format in which information is 

displayed when viewing details associated with a 
specific person. 
 

Add Person Flex Form box  Select a defined flex form from the list to be used as 
a default when registering new persons. 
 

Modify Person Flex Form box   Select a defined flex form from the list to be used as 
a default when modifying information associated 
with previously defined persons. 
 

View Encounter Flex Form box  Select a defined flex format from the list to be used 
as a default when viewing encounter information 
associated with the appointment. 
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Add Encounter Flex Form box   Select a defined flex form from the list to be used as 

a default when adding new encounters. 
 

Modify Encounter Flex Form 
box   

Select a defined flex form from the list to be used as 
a default when modifying information associated 
with a previously defined encounter. 
 

Cancel Encounter Flex form 
box 

Select a defined flex form from the list to be used as 
a default when canceling an encounter. 
 

Default Location box   Select a location from the list to be entered as a 
default location when you are scheduling 
appointments.  For example, if you consistently 
schedule for a particular location, selecting that 
location as your default would allow it to be entered 
automatically when you are scheduling 
appointments.  However, if you are scheduling an 
appointment type that has not been associated with 
your default location, you must select an appropriate 
location from the list that will be associated with the 
appointment type. 
 

Add person and encounter 
check box   

Select this box if you want to add a person and 
encounter at the same time. 
 

Appointment Detail Fields box   The required details (Appointment Type, 
Appointment Location, and Person) are displayed.  
This information is required for an appointment to 
be scheduled, regardless of what other information is 
needed for the appointment type.  Since these three 
boxes are required, you can determine the order in 
which you want them to display for your 
convenience. 
 

Up Arrow button   Moves the detail up the list.  This will affect the 
order in which the boxes are displayed in the 
Appointment tab. 
 

Down Arrow button   Moves the detail down the list.  This will affect the 
order in which the boxes are displayed in the 
Appointment tab. 
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2.18.4 Confirm Tab Description 
 
Always Create New Encounter 
When Required box   

Select this box if a new encounter is to be created 
during the confirm process.  This is applicable if the 
appointment type requires an encounter to be 
associated with it, and if an encounter has not 
already been associated with the appointment. 
 

 
 
2.18.5 Check In Tab  Description 
 
View Person Flex Form box   Select the format in which information is displayed 

when you click View in the Check In dialog box. 
 

Modify Person Flex Form box Select the format in which information is displayed 
when you click Modify in the Check In dialog box. 
 

Add Encounter Flex Form box Select a defined flex form from the list to be used as 
a default when adding new encounters. 
 

View Encounter Flex Form box Select a defined flex form from the list to be used as 
a default when viewing encounters. 
 

Modify Encounter Flex Form 
box 

 Select a defined flex form from the list to be used as 
a default when modifying information associated 
with a previously defined encounter. 
 

Check In Warning Range box Enter the number of minutes prior to the scheduled 
appointment time in which an appointment can be 
checked in without a warning message being 
displayed to the user.  This time range affects 
whether the appointment will be rescheduled by the 
system or just checked in early. 
 

Always Create New Encounter 
When Required box   

Select this box if a new encounter is to be created 
during the confirm process.  This is applicable if the 
appointment type requires an encounter to be 
associated with it, and if an encounter has not 
already been associated with the appointment. 
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2.18.6 Check Out Tab Description 
 
View Person Flex Form box Select the format in which information is displayed 

when you click View in the Check Out dialog box. 
 

Modify Person Flex Form box Select the format in which information is displayed 
when you click Modify in the Check Out dialog box. 
 

Add Encounter Flex Form box Select a defined flex form from the list to be used as 
a default when adding new encounters. 
 

View Encounter Flex Form box Select a defined flex form from the list to be used as 
a default when viewing encounters. 
 

Modify Encounter Flex Form 
box 

  Select a defined flex form from the list to be used 
as a default when modifying information associated 
with a previously defined encounter. 
 

Allow Discharge box   Select this box to allow discharges when you check 
out a person from the Check Out dialog box. 
 

Always Discharge box. Select this box if the person should be discharged 
every time you check someone out using the Check 
Out dialog box.  If this option is selected and the 
Interactive Discharge Using Discharge Flex Form 
option is not selected, the discharge will occur 
automatically in the background and you will not 
need to perform any further actions to discharge the 
person 
 

Interactive Discharge box   Select this box to open a dialog box that allows you 
to enter additional information when you are 
discharging someone.  If this option is not selected, 
the discharge process occurs in the background with 
no additional information required. 
 

Discharge Flex Form box   Select a defined flex form to be used as a default 
when discharging a person.  This field is available 
only if you checked the previous box. 
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2.18.7 PM ToolBar Tab 
 
View Person Flex Form box   Select a defined format in which information is 

displayed when viewing details associated with a 
specific person. 
 

Add Person Flex Form box   Select a defined flex form from the list to be used as 
a default when adding a new person to the database. 
 

Modify Person Flex Form box Select a defined format in which information is 
displayed when modifying details associated with a 
specific person. 
 

View Encounter Flex Form box Select a defined flex format from the list to be used 
as a default when viewing encounter information 
associated with the appointment. 
 

Add Encounter Flex Form box Select a defined flex form from the list to be used as 
a default when adding a new encounter. 
 

Modify Encounter Flex Form 
box. 

Select a defined flex form from the list to be used as 
a default when modifying information associated 
with a previously defined encounter 
 

OK button Saves the information and closes the dialog box. 
 

Cancel button Closes the dialog box without applying the 
information displayed. 
 

 
 
2.18.8 View menu: 
 
 
Actionbar   Toggles the actionbar.  A check mark next to this 

command indicates the actionbar is visible. 
 

Sizebar Toggles the sizebar.  A check mark next to this 
command indicates the sizebar is visible. 
 

Viewbar   Toggles the viewbar.  A check mark next to this 
command indicates the viewbar is visible. 
 

Application bar Toggles the application bar.  A check mark next to 
this command indicates the application bar is visible. 
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Help bar   Toggles the What's This Help button.  A check mark 

next to this command indicates the help bar is 
visible. 
 

Demographics Bar   Toggles the demographics bar.  A check mark next 
to this command indicates the demographics bar is 
visible. 
 

Availability Bar Toggles the availability bar.  A check mark next to 
this command indicates the availability bar is visible. 
 

Status Bar   Toggles the status bar.  A check mark next to this 
command indicates the status bar is visible. 
 

Small Buttons Decreases the size of the icons in the toolbar.  A 
check mark next to this command indicates this 
option is active. 
 

Large Buttons Enlarges the icons in the toolbar.  A check mark next 
to this command indicates this option is active. 
 

Cancels Indicates that canceled appointments are displayed.  
A check mark next to this command indicates this 
option is active. 
 

Reschedules   Indicates that rescheduled appointments are 
displayed.  A check mark next to this command 
indicates this option is active. 
 

Held Appointments   Indicates that appointments in a held status are 
displayed.  A check mark next to this command 
indicates this option is active. 
 

Empty Schedules.   Indicates that all resource schedules will be 
displayed.  A check mark next to this command 
indicates this option is active.  If there is no check 
mark next to this command, only resource schedules 
with appointments will be displayed.  If a default 
schedule is applied to the resource, that resource is 
not considered to have an empty schedule so it will 
be displayed. 
 

Refresh Updates the displayed information to reflect changes 
in the database. 
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Options Opens the Options dialog box in which you can 

define your default preferences. 
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HOW TO SET UP FUTURE CASE/REQUEST LIST APPOINMENT FEATURE 
 
These are the steps to make sure you review if a case is already on the request list or is scheduled in the future.  If you set the settings 
correctly ORMA will have you verify the case you are planning to schedule . These are the settings you need to make to take 
advantage of this feature.  Please pass this info on to All Surgeons and clerical staff. 

 

Select <View>, and then select 
<Options> 

 

1 of 9 



 

Make sure these Boxes are 
selected so it will hunt for 
cases listed in the request 
lists and any other future 
scheduled/confirmed cases 
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With The above 
settings turned on, 
if you were to 
begin to schedule a 
patient named: 
Test, Male, the 
box to the left 
would pop up 
before you were to
go any further.  
The top arrow 
indicates the 
patient has a valid 
“request list” place 
and the bottom 
arrow points to 
another case for 
this patient who 
has a confirmed 
date.  In order to 
check what the 
surgery request 
and or the 
confirmed case is, 
see next frame! 

 

 
 

3 of 9 



Note the information above tells you the 
case is confirmed for surgery on 
2/18/2004 and who created the case in 
the scheduling application 
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First highlight 
the case you 
want to check 
as indicated by 
the arrow, then 
double click.
And the screen 
to the left will 
pop up.  Now 
select the tab 
marked 
“Orders” , see 
the planned 
procedure.  If 
you need 
additional 
information
then select the 
tab marked 
“event details” 

 

 



 

In this case you can see the case planned for is noted in the 
Orders Tab. 

Now select <C SE> 
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If the case is the one you were going to schedule, 
Highlight the case above and then click on 
<SELECT>, If not check, the Future Patient 
Appointment in the same manner. If it is the one 
you want, highlight and the <Select>  If neither 
applies, just click on <OK> and schedule 
normally 
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In this Case, I am going to select the 
“Request List Case” so I Highlighted and 
then clicked on <Select> Notice the Red 
Check mark…..   No click on <OK> 
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After going through the <allergies> screen, go right to the Procedure /ORDER Details by passing the normal questions in the details 
window.

 

f 

If you want to double check the details or 
change the residents/primary doc just click on 
the <Details> tab above , make changes then 
come back to the <Orders> tab, make changes i
needed and scheduled in the usual manner. 
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That is all you need to do.  The best part is the case is then removed from its previous date or request list so you don’t have to go back 
and clean up lists or worry about double scheduling.   This is active in PROD as of 2/24/2004. 
 
If you have any questions or do not understand how to work this, call me at 253-968-5562. 
 
Joel M. Messing 
ORMA ADMIN 
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